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Use Case Diagram
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Use Case Specifications

Make Emergency Call
ID: 1
Brief Description: Attempt to contact someone to notify them that an emergency has occurred and
requires the attention of an emergency service or caregiver.
Primary Actors: Elderly or Assistive Person
Secondary Actors: Emergency Contact
Preconditions:
* The user is running the HCPA.
Main Flow:
1. Onany page, the user selects the emergency button.
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Include (‘Send Emergency SMS’)

The system immediately begins looping through the emergency contacts, attempting to
establish a phone call

Once a call goes through, the phone notifies the user

The user talks on the phone, explaining their situation and hangs up when complete
The system asks the user if the emergency is handled

If the user selects no or does not respond in 2 minutes, return to step 3

Include(‘Send Emergency SMS’) send “Issue averted”

Postconditions:

Emergency contacts notified

Alternative Flows:

If during the sequence a call comes in, the system pauses it’s dialing cycle to answer the call. Go
to step 5.

If a cellular signal cannot be reached, notify the user and continue trying to connect
If the user at any point in the main flow selects cancel, skip to step 8

% X

‘User :System :EmergencyContact

il lnitiateEmergencyCaIIing()’h

loop J

[not IssueResolved]

Call(contact)

ke

ContactUnreachable
alt [ ] CannotReach

Notify()

ExplainSituation

[otherwise] ¢
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Send Emergency SMS
ID: 2
Brief Description: Attempt to contact someone to notify them that an emergency has occurred and
requires the attention of an emergency service or caregiver. Use a means that allows for maximum
reach.
Primary Actors: Elderly or Assistive Person
Secondary Actors: Standby Contact
Preconditions:
* The user is running the HCPA and a list of standby contacts has been setup
Main Flow:
1. The system loops through the contact list
2. If the contact is marked as an emergency contact, send the message “l am in need of assistance,
if you are nearby, please seek me out immediately” via SMS to the contact.
Postconditions:
* Standby contacts notified
Alternative Flows:
* If given another string as input, send that in step 2, rather than the listed string.

:System %
:StandbyContact
N |
) |
|
loop / [AnotherContact] I
" SendSMS(message) |
M [isStandbyContact] ( 0 )m
|
|
- |
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Add Contact
ID: 3
Brief Description: Add a contact to the HCPA database

Primary Actors: Elderly or Assistive Person
Secondary Actors: None
Preconditions:
* The user is running the HCPA and is on home screen
Main Flow:
1. User clicks on contacts; the system displays contact list
2. User clicks on add contact; the system prompts for the following information:
a. Name
b. Number
c. Is Emergency Contact?
d. Breadcrumb
3. The user submits the data; the system commits the contact to the database.
4. The contact list screen is displayed.
Postconditions:
* Either the new contact is persisted in the database or no changes are made
* The system returns to the contact list.
Alternative Flows:
* |f at step 3 in the main flow the user cancels the addition, the system aborts any changes to its
database. Flow continues as normal.

X

User :System
,  SelectMenu("Contacts") J.
DrawMenuContents("Contacts")
pam|
Selectitem("Add Contact")
CreateNewContact()
alt ) ......... contactinfo |
[not Cancelled] <<submit>> SaveContact(contactinfo)
I R I o
[otherwise] | [~ """ " "o oottt
<<cancel>>
DrawMenuContents("Main")
pam|
1 T
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Generate Sentence
ID: 4
Brief Description: Generate a new sentence from scratch and read it using text-to-speech libraries.
Primary Actors: Elderly
Secondary Actors: Assistive Person
Preconditions:
¢ The user is running the HCPA and is in the sentence creation dialog
¢ The list of most recently used sentences is initialized (though perhaps empty)
Main Flow:
1. The user enters, via keyboard, the new sentence to be generated
The user presses the speak button; the system disables editing.
The system renders the audio using text-to-speech libraries
The system adds the sentence to the most recently used list
The system re-enables editing of the sentence field
6. The assistive person reacts accordingly
Postconditions:
* The message is conveyed to the assistive person
Alternative Flows:
e If at step 1in the main flow the user selects the home button, abort all operations and exit the
sentence creation dialog.
¢ If after step 5 in the main flow the user modifies the sentence, return to step 1.
e If at step 6 in the main flow the assistive person does not hear the output, the user may return

to step 2.
% Systen] -

:User :AssistivePerson

e wnN

Ioﬂ) EnterText(text) |
ButtonPressed("Speak") Editable(false) |
= |
Render(text) n
AddToMRU(text)
=
Editable(true)
—
oo oo |
opt Respond _‘

opt ButtonPressed("Clear") EnterText("™) |
o= |
|
T
T T [
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Give Opinion
ID: 5
Brief Description: The system renders a pre-generated sentence, giving an opinion, using text-to-speech
libraries.
Primary Actors: Elderly
Secondary Actors: Assistive Person
Preconditions:
* The user is running the HCPA and is in the pre-set opinions menu
¢ The list of most recently used sentences is initialized (though perhaps empty)
Main Flow:
1. The user selects the icon of the opinion that they wish to express
2. The system uses text-to-speech rendering to speak the sentence
3. The system adds the sentence to the most recently used list
4. The system returns to the pre-set opinions menu
Postconditions:
¢ The message is conveyed to the assistive person
Alternative Flows:
* If the assistive person does not get the message, begin again at step 1.
5 [System 2
:User :AssistivePerson
| Selectitem(opinion) | |

Render{opinion.sentence)

AddToMRU(opinion.sentence, opinion.icon) >I}I
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Greet
ID: 6
Brief Description: The system renders a pre-generated sentence, greeting an assistive person, using
text-to-speech libraries.
Primary Actors: Elderly
Secondary Actors: Assistive Person
Preconditions:
* The user is running the HCPA and is in the pre-set greetings menu
¢ The list of most recently used sentences is initialized (though perhaps empty)
Main Flow:
1. The user selects the icon of the greeting that they wish to express
2. The system uses text-to-speech rendering to speak the sentence
3. The system adds the sentence to the most recently used list
4. The system returns to the pre-set greetings menu
Postconditions:
¢ The message is conveyed to the assistive person
Alternative Flows:
* If the assistive person does not get the message, begin again at step 1.
5 [System 2
:User :AssistivePerson

| Selectltem(greeting) | |

Render(greeting.sentence)

AddToMRU(greeting.sentence, greeting.icon) ?
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Label Picture
ID: 7
Brief Description: Associate a custom icon with custom text for use in the system
Primary Actors: Elderly or Assistive Person
Secondary Actors: None
Preconditions:
* The user is running the HCPA and is in the Image Glossary (under Settings)
Main Flow:
1. The user selects the New Entry button
The system requests the image file, a sentence, and the location of the icon in the menus.
The user enters the requested information and clicks the Add button
The system validates the input information
The system persists the association
6. The system inserts the new icon in the appropriate menu
Postconditions:
* Anewicon is created at the proper location
Alternative Flows:
* |f at step 4 in the main flow the image file or menu location does not exist, the system displays
an error and aborts the use case
* |f at step 4 in the main flow the system finds that at the image or its associated sentence is
already in the image glossary (bit-for-bit), then the system displays an error and aborts the use

uhwnN

case
5{ :System I
:User
J.‘ Selectitem("New Entry") l
icon = new Icon()
EditAssociation(icon) pa
J ____________________________________ 5 Validate(icon)
=
alt .
DisplayError()
Cfemon |0
[otherwise] Save(icon)
y
AddToMenu(icon, menu)
=
(--{

_t — — —
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Change Preset Sentence

ID: 8

Brief Description: Change an existing image-to-text association throughout the system.
Primary Actors: Elderly or Assistive Person

Secondary Actors: None

Preconditions:

* The user is running the HCPA and is in the Image Glossary (under Settings)
Main Flow:

1. The user finds and selects the icon in the image glossary; the system brings up an edit dialog
The user changes at least one of the following values: Image File, Sentence, Menu Location.
The user clicks the Save button
The system validates the input information
The system persists the association
If the Menu Location was changed in step 2, the system removes the icon from the old menu
and inserts it into the new one
Postconditions:

* The existing icon is re-purposed as per the user’s customization
Alternative Flows:

* |f at step 4 in the main flow the image file or menu location does not exist, the system displays

an error and aborts the use case

* |f at step 4 in the main flow the system finds that at the image or its associated sentence is

already in the image glossary (bit-for-bit), then the system displays an error and aborts the use

ok wN

case
% |:System |
:User
J‘I Selectitem(icon) l
EditAssociation(icon)
J ____________________________________ 3 Validate(icon)
I
(-.,
at DisplayError()
[Error]
lotherwisell ]~ =~ ~ ~ ~ = "|[Ssavelicon) ~— ~— T ]
€
é--’
opt RemoveFromMenu(icon, oldMenu)
. =
[LocationChanged]| | |---
AddToMenu(icon, menu)
yum|
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Change Layout
ID: 9
Brief Description: Customize the number of icons on the screen for easier viewing.
Primary Actors: Elderly or Assistive Person
Secondary Actors: None
Preconditions:
* The user is running the HCPA and is in Settings menu
Main Flow:
1. The user selects the Layout menu item
The system queries the user for one of the following layouts: 4, 6, 9, 16
The user selects the desired layout and presses the Save button
The system persists the setting in the configuration file
The system returns to the Settings menu and redraws it to have the selected number of icons on
the screen
Postconditions:
* The number of icons per screen is set for current and future use
Alternative Flows:
* |f the user selects the Cancel button (before step 4), then the screen returns to the Settings
menu and no changes are made to the configuration.

uhwnN

;‘E :System
:User
L Selectitem("Layout") 1

DisplayLayoutOptions()

rFS

alt cancel
Eancall| | 3

[otherwise] layoutinfo

Save(layoutinfo)

I3

DrawMenuContents("Settings")

L]C’
P

T
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View Recently Used
ID: 10
Brief Description: Open a menu to view the most recently used sentences by the text-to-speech system.
Primary Actors: Elderly or Assistive Person
Secondary Actors: None
Preconditions:

e The user is running the HCPA and is on the home screen

* The user has previously generated sentences using the Generate Sentences use case
Main Flow:

1. The user selects the most recently used menu.

2. The system queries the most recently used list and displays the 10 most recent sentences
Postconditions:

* The user can see and select from any of the 10 most recently generated sentences
Alternative Flows: None.

7% :System
:User

1 Selectitem("Recently Used List")

QueryMRU()
yum

T(.'J
DrawMenuContents(mru)
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Set Schedule Reminders

ID: 11

Use Case Specifications

Brief Description: Cause the application to post a reminder to the user about a specific event in their

schedule.

Primary Actors: Elderly or Assistive Person
Secondary Actors: None

Preconditions:

* The user is running the HCPA and is in Tools menu

Main Flow:

1. The user clicks on the Schedule Reminder menu

2. The system opens the menu consisting of existing events

3. The user clicks on the New Event button

4. The system brings up a dialog prompting for the following:
a. Time
b. Date
c. Recurrence

5. The user submits the information to the system

6. The system persists all data and sets an alarm

Postconditions:

* Anew alarm is added to the system at the specified date/time(s)

Alternative Flows:

¢ If the user presses the Cancel button at any time all changes are aborted and the use case is

exited

X

:User

|
1

:System

Selectltem("Schedule Reminder")

|
il

Selectlitem("New Event")

CreateEvent()

DisplayMenuContents("Schedule Reminder")

pam

Save(event)

)

<..,
SetAlarm(event)
!
<..,'
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Set Drug Reminder
ID: 12
Brief Description: Cause the application to post a reminder to take medication or that the supply of
drugs is running low.
Primary Actors: Elderly or Assistive Person
Secondary Actors: None
Preconditions:
* The user is running the HCPA and is in Tools menu
Main Flow:
1. The user clicks on the Drug Reminder menu
2. The system opens the menu consisting of existing reminders
3. The user clicks on the New Reminder button
4. The system brings up a dialog prompting for the following:
a. Prescription Name
Doctor Name
Doctor SMS-capable phone number
Pharmacy SMS-capable phone number
Days of week to take
Times of day to take
Number of pills to take each time
Size of prescription (# of pills)
. Number of authorized refills
5. The user submits the information to the system
6. The system queries the HOPE prescription database using the Prescription Name
7. The system downloads from the database the following data
a. List of drugs to avoid while taking this prescription + duration of avoidance
b. Take with food, without food, or apathetic?
8. The system checks all existing drug reminders for conflicts (see 7a)
9. The system persists all data and sets a recurring alarm
Postconditions:
* Anew drug reminder is set up to recur at the specified times
* |f the doctor’s SMS-capable phone number is supplied, the doctor will be notified 7 days in
advance that we will require a refill
¢ If the pharmacy’s SMS-capable phone number is supplied, the pharmacy will be notified 5 days
in advance that we will require a refill
Alternative Flows:
* |f at step 6 the database query comes up empty, skip steps 7 & 8 and the system shall inform the
user that no data could be downloaded for the drug. Allow the user to cancel.
* |f at any step the user selects Cancel, abort all changes to the system and exit the use case

TS o o0 o
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:User
|
|

Selectitem("Drug Reminder") 1

DisplayMenuContents("Drug Reminder")
|

Selectitem("New Reminder")

CreateDrugReminder()

¢
U reminder ]
QueryPrescriptionDetails(reminder.drugName)

I
I
I
I
I
I
I
I
a_'t) [found] Commimmies :‘rimig?g'e't'_éi'l S_ iy :‘::I:
|
I
I
I
I
I
I
I
I
|

[otherwise] NotFound
Notify() O

opt Notify()

Save(reminder)
—
3
SetAlarm(reminder)

—_———
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Drug Reminder
ID: 13
Brief Description: The system notifies the elderly that it is time to take their drugs
Primary Actors: System
Secondary Actors: Elderly
Preconditions:
* The user is running the HCPA
* The user previously set up drug reminders using the Set Drug Reminder use case
* The current time is when a drug reminder is set to go off
Main Flow:
1. The system displays a notification that it is time to take their drugs. The message contains the
list of drugs to take and the quantities of each.
The user takes the drugs and then clicks the ‘I have taken all pills’ button
The system prompts for confirmation; the user confirms they took the pills
The pill counts are updated and persisted
If the pill count has declined below the threshold (5 or 7 days worth) and the SMS-capable
phone number is supplied, the system sends a message requesting a refill.
Postconditions:
* The count of pill remaining is updated
* Any necessary refill requests are made
Alternative Flows:
* |f at step 2 the user clicks Snooze and supplies a time (less than 2 hours), the system closes the
reminder, waits the specified time and begins again at step 1
* |If at step 2 the user clicks ‘I did not take my pills’ the system skips aborts any changes and exits
the use case

uhwnN

:User
1 DrugNotification(reminder) |
alt snoozeTime
"""""""""""""""""""""""" SetTempReminder(reminder, snoozeTime)
[Snoozel
I
[DidNotTake] |  dismissed ([~~~ T 7]
[TookPills] pillsTaken
-|— """"""""""""""""""""""""" UpdatePillCount(reminder, pillsTaken)
=
| =
| opt) RequestRefill(reminder)
| [LowOnPills] <
|
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Domain Description Class Diagram

Breadcrumb SoundFile
+previousImage +soundFileName
User +nextimage 1
+userName
1 1
+addCategory()
+viewCategory() 1
+removeCategory() 1 1
+placeEmergencyCall) | 1 Category Icon
+search() =
+customize() +categoryName 1 1 +mageName
1= +categoryID WIS +imageSize
+createCategory() +changeSize()
+displayCategoryContents() +changelLayout()
+deleteCategory()
Contacts ? .
EmergencySystem e CeaTene Help
+contactName +emergencyMode
+contactNumber = ~greetingText +sentenceText
+contactPhoto .- 1 | 4placeEmergencyCall() ~greetingID +sentencelD
+sendSMSQ) —greetingSound +sentenceCategory
+repeatEmergencyCall() -greetinCategory
+storeGreeting()
+assiciateWithPhoto() HelpSystem
+editGreeting() PV
SentenceGenerator
+addNewSentence()
+addSentenceToFavorites()
+removeSentence()
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